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Diazepam Metabolism in Vitro: 
Michaelis-Menten Kinetics 

 

Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Numerical.” 

 

What you will learn in this case study 
 

 How to change the name of the independent variable “t” to “s”. 
 How to create a Michaelis-Menten enzyme kinetic model. 
 How to fit the model to the data. 
 How to produce the Lineweaver-Burke, Hanes and Eadie-Hofstee plots. 

 

Data Required 
 

The data file for this case study is 
 

diazep_1.dat 
 
The data file is discussed in the introduction. 

 

Introduction 
 
Analysis of processes involved in the transport and metabolism of a number of drugs and 
other compounds may require the use of models that incorporate the Michaelis-Menten 
equation which has the form: 
 

 
v 

VmaxC

Km C  
 

 
where v  is the velocity of the reaction, C  is the concentration of substrate, Vmax  is the 
maximal velocity of the reaction, and Km  is the substrate concentration when 
v  Vmax / 2 .  The goal of an investigator is to estimate Vmax  and Km .   
 
The use of human liver samples and microsomes has played an increasingly important 
role in identifying the different cytochrome P450 drug metabolizing enzymes, referred to 
as CYPs, and in elucidating drug metabolic pathways and rates during preclinical drug 
development and subsequent metabolism and pharmacogenetic investigations.  This case 
study is based on an in vitro analysis of diazepam (Valium) metabolism using human 
liver microsomes [1].  As shown below, diazepam metabolism is mediated by a number 



Numerical Case Study Diazepam Kinetics: Michaelis-Menten Analysis 

 Diazep - 2 Rev. 11/05.26 

of P450 enzymes and proceeds by both N-dealkylation and C3-hydroxylation. This 
results in more kinetic complexity than if a single metabolic pathway and P450 enzyme 
were involved. 
 

 
 
 
Investigators traditionally have transformed their data to estimate Vmax  and Km   values 
and to evaluate the appropriateness of Michaelis-Menten models.  The Lineweaver-Burke 
is probably the most common transformation.  In this so-called double reciprocal plot, 
one writes 
 

1

v


Km

Vmax


1

C


1

Vmax

 

 
In other words, one transforms the data so that the reciprocal of the velocity can be 
plotted as a function of the reciprocal of the substrate concentration.  If a single 
Michaelis-Menten expression is appropriate for the data, the double reciprocal plot is a 
straight line from which it is easy to estimate Vmax  and Km . 
 
Two other linearizing plots are the Hanes and Eadie-Hofstee. The Hanes equation is: 
 

 C
VV

K

v

C m *
1

maxmax

  

 
and the Eadie-Hofstee equation is: 
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maxV
C

v
Kv m 






  

  
The Hanes equation is also a straight line whose slope is 1/Vmax and intercept Km/Vmax. 
The Eadie-Hofstee plot is a plot of v against v/s whose slope is Km and intercept Vmax 
on the v-axis and Vmax/Km on the v/s axis. The Eadie-Hofstee plot is useful in that it 
magnifies any departure of linearity (meaning there is more complexity than a single 
Michaelis-Menten term in the data) more than the Lineweaver-Burke plot 
 
These and other transformations have a tendency to produce estimates of Vmax  and Km  
that are in error because the error structure in the data has not been handled properly in 
the transformation. More specifically, if d1 is a datum with standard deviation sd1, then 
the standard deviation of 1/d1 is not 1/sd1.  The result of these manipulations of the data is 
that smaller data end up with larger weights resulting in a skewing of the curve, and 
erroneous estimates of the desired parameters. 
 
In this case study, you will learn how to fit the Michaelis-Menten model directly to your 
data thus eliminating the error problems caused by the transformations, and produce the 
desired transformation plots which are often more useful in presenting results. 
 
1.  Kato, R., Yamazoe, Y. “The importance of substrate concentration in determining 

cytochromes P450 therapeutically relevant in vivo.” Pharmacogenetics 1994,4:359-
62. 

 
Computational Options 
 
To create your Michaelis-Menten model, you have two choices. One is to use the 
Equation Builder in the SAAM II Numerical Toolbox. The other is to enter the 
equations directly, which is what we will do in this case study. 
 
To use the Equation Builder in the SAAM II Numerical Toolbox, you click on 
Equation Builder tool. The Equation Builder dialog box will open as follows: 
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There are many pre-defined options available. If you select the Michaelis-Menten option 
and, for example, change the Number of Terms from “3” to “2”, the Equation Builder 
dialog box will appear as follows: 
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If you now click Paste Equations, the following equations will appear on the SAAM II 
Numerical Working Canvas: 
 

 
 
 
The first equation is the velocity reaction containing the linear term kat  where ka  is a 
parameter to be estimated, and two Michaelis-Menten terms where the two maximal 
velocities V max1a  and V max2a  and two half-saturation concentrations Kd1a  and 
Kd2a  (the equivalents of Km  in the Michaelis-Menten equation, and used 
interchangeably depending upon the situation) can be estimated from the data.  In this 
expression, the independent variable is written t ; this is concentration rather than the 
time.  The additional equations va_ recip  and t _recip  let you set up the Lineweaver-
Burke plot. 
 
In this case study, we will not use the predefined equations because we will use “s” 
instead of “t” as the independent variable. In addition, besides the Lineweaver-Burke 
plot, we will also show how to create the Hanes and Eadie-Hofstee plots. 
 
The data generated from the Km and Vmax estimates of Kato and Yamazoe (see [1] above) 
are shown below: 
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s sample1
0 n
5 7.77E-02
10 0.135
20 0.238
40 0.352
60 0.446
80 0.549
100 0.655
120 0.694
140 0.743
160 0.852
180 0.871
220 0.99
240 1.039
260 1.047
280 1.043
300 1.129
320 1.101
340 1.153
360 1.185
380 1.274
400 1.291  

 
Diazepam concentration is given in the “s” column and a measure of the velocity of the 
reaction is in the “sample1” column (the units are nmol min-1/mg P450 protein). These 
are the data that will be described by the Michaelis-Menten model. However, to produce 
the Lineweaver-Burke, Hanes and Eadie-Hofstee plots, the data need to be transformed. 
The easiest way to do this is using a spreadsheet. 
 
To produce the Lineweaver-Burke plot, you need the reciprocal of the sample. We will 
call this smp1recip. This can be calculated by taking the reciprocal of each sample. In the 
data shown below, these appear in the column “smp1recip”. For the Hanes plot, you need 
the quotient of the concentration and velocity, s/sample1. These are given in the column 
“smp1sv” column below. Finally, for the Eadie-Hofstee plot, you need the quotient of the 
sample divided by the velocity, sample1/s. These appear in the column “smplvs”: 
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s sample1 smp1recip smp1sv smp1vs
0 n n n n
5 7.77E-02 12.870 64.350 0.01554
10 0.135 7.407 74.074 0.01350
20 0.238 4.202 84.034 0.01190
40 0.352 2.841 113.636 0.00880
60 0.446 2.242 134.529 0.00743
80 0.549 1.821 145.719 0.00686
100 0.655 1.527 152.672 0.00655
120 0.694 1.441 172.911 0.00578
140 0.743 1.346 188.425 0.00531
160 0.852 1.174 187.793 0.00533
180 0.871 1.148 206.659 0.00484
220 0.99 1.010 222.222 0.00450
240 1.039 0.962 230.991 0.00433
260 1.047 0.955 248.329 0.00403
280 1.043 0.959 268.456 0.00373
300 1.129 0.886 265.722 0.00376
320 1.101 0.908 290.645 0.00344
340 1.153 0.867 294.883 0.00339
360 1.185 0.844 303.797 0.00329
380 1.274 0.785 298.273 0.00335
400 1.291 0.775 309.837 0.00323  

 
These are the data in the file diazep_1.dat. 
 
 
Part 1.  Analyze data from a process believed to exhibit Michaelis-Menten kinetics. 
 
In this part of the case study, you will plot the data to determine what kind of a 
Michaelis-Menten model you will use first. For the model, there are essentially three 
choices: a single Michaelis-Menten term, a single linear and a single Michaelis-Menten 
term, and two Michaelis-Menten terms. You would choose the first if the Lineweaver-
Burke and Eadie-Hofstee plots of the data are straight lines. You would choose the 
second if the last part of the data plot is a straight line. You would choose the last if the 
last part of the curve of the data still exhibited curvature, and neither the Lineweaver-
Burke nor Eadie-Hofstee plots are linear. Thus in examining the data, you will look at a 
plot of the data, and the Lineweaver-Burke and Eadie-Hofstee plots. 
 

1. Start the SAAM II Numerical application. The SAAM II Numerical main 
window will open as follows: 
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2. Specify the experimental attributes. 
 

a. In the Set menu, click Experimental Attributes. The Experimental 
Attributes dialog box will open. 

 
b. In the Independent Variable box, rename “t” to “s”. 
 
c. In the Units box, type “concentration”.   
 
d. In the End At box, enter “400”. The Experimental Attributes dialog box 

will appear: 
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e. Click Done. 
 

3. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file diazep_1.dat should appear in the list 

(if it does not, find the folder where you put this data file). 
 
c. Double-click diazep_1.dat. The data in this file will appear in the Data 

window as follows: 
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 The data file. The contents of the data file have been explained in the 
introduction. The column “sample1” are the actual data while the remaining 
columns are transformed data that will permit the Lineweaver-Burke, Hanes 
and Eadie-Hofstee plots. 

 
 

d. Close the Data window. 
 

4. View your data using a line plot. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. 
 
b. Be sure the List All Variables check box is selected. (Click this box if it is 

not selected). 
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c. Click sample1 to move it to the Current Selection pane. The Plot and Table 
Variables dialog box will appear as follows: 

 

 
 
 Note the name of the variable on the X-Axis is “s”, the name of the 

independent variable you assigned in the Experimental Attributes dialog 
box. 

 
d. Click Done. A plot of the data will appear in the Plot window. It is useful to 

change the scale. 
 
e. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. Change the Y-Axis scale as shown in the follow Plot and 
Table Scale dialog box: 
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f. Click Done.   
 
g. In the View menu, click Line Plot. If the plot is not in linear mode, in the 

View menu, click Semilog to make the plot linear. Your plot will appear as 
follows: 

 

 
 

You can see there is still some curvature towards the end of the data, so a 
linear component to your model (discussed below) will not be tested. 

 
h. Close the Plot window. 
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  Line Plots. The data can be visualized as a linear or semilog plot after they 
have been loaded into the SAAM II Data window. This can be very useful in 
helping you decide with which model you would like to start your data 
analysis 

 
 

5. View your data using the Lineweaver-Burke and Eadie-Hofstee plots. 
 

Remember the Lineweaver-Burke equation is: 
 

1

v


Km

Vmax


1

C


1

Vmax

 

 
In our model, “s” will play the role of “C” in the equation. So the Lineweaver-
Burke plot is a plot of “1/s” versus 1/v. The data have already been entered in the 
Data window transformed for this plot; they are called “smp1recip”. Thus to 
produce the Lineweaver-Burke plot, we need to specify “1/s”. This is done by 
entering an equation on the Working Canvas. 

 
a. Type the following on the Working Canvas:  
 

# 
# The following equation defines a variable for the Lineweaver-Burke plot. 
# The addition of the term "0.00001" in the denominator for s_recip will  
#    prevent division by zero when s = 0. 
# 
s_recip = 1/(s + 0.00001) 
# 

 
  The Working Canvas will appear, in part, as follows: 
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 Comments in SAAM II Numerical. Comment lines can be added to your 
equation set by starting the comment line with the pound key “#”. 

 
 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Your previous plot of the data (no line plot) should appear. 
 
c. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog bow will open. Be sure the List All Variables check box is selected. 
(Click this box if it is not selected). 

 
d. Type “s_recip” in the X-Axis box (this will change the variable on the X-Axis 

from “s” to “s_recip.) 
 
e. Click smp1recip in the Variable for Y-Axis pane to move this to the 

Current Selection pane. 
 
f. Click Done. The Plot window will appear with nothing in it. This is because 

SAAM II remembers the plot scale you set previously when you examined the 
data. You need to reset the plot scale. In addition, you need to Solve in order 
to activate the equation “s_recip = 1/(s + 0.00001). 

 
g. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
h. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. Change the X-Axis and Y-Axis scales as shown in the follow 
Plot and Table Scale dialog box: 
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 Setting the X-Axis scale. The reason why the X-Axis scale had to be changed 
was because you were plotting (1/s) as the variable. The values for “s” range 
from “0” to “400”. Of course there is no “1/0” possible, so SAAM II 
substituted a very large number. The first datum for “s” was “5” the reciprocal 
of which is 0.2. Choosing “0.25” as the Maximum just gives a little more 
room on the plot. 

 
 
i. Click Done.  Your plot will appear as follows: 
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You can see this plot is not linear, so more than one Michaelis-Menten term 
will be required in your model. If you create a plot as a line plot, the 
deviation, especially at the beginning, will be evident. 

 
j. Leave the Plot window open. 
 

You will now examine the Eadie-Hofstee plot. Remember the Eadie-Hofstee equation 
is: 
 

maxV
C

v
Kv m 






  

 
Remembering “C” is replaced by “s” in our model, this is a plot of the data divided by 
“s” versus “s”. The corresponding “v/C” has been calculated in the Data window; it 
is in the column named “smpl1vs”. 

 
k. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
 
l. Type “s” in the X-Axis box (this will return the variable on the X-Axis from 

to “s” from “s_recip.) 
 
m. Click smp1vs in the Variable for Y-Axis pane to move this to the Current 

Selection pane. The Plot and Table Variables dialog box will appear as 
follows: 
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n. Click Done. You will need to reset your plot scale as follows: 
 

 
 
o. Click Done. Your Eadie-Hofstee plot will appear as follows: 
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It is clear this plot is not linear; it is even more obvious than with the 
Lineweaver-Burke plot. Thus the data contain more complexity than a single 
Michaelis-Menten term. 

 
p. Close the Plot window. 
. 

 
Part 2. Specify the model of the data 
 
Your pre-analysis of your data has led you to the conclusion that your initial model 
should contain two Michaelis-Menten terms. If you were unsure about whether a linear 
term was needed, you could first start with a linear plus a single Michaelis-Menten term. 
You will use the two Michaelis-Menten term model. 

 
1. Specify the model for the data. 
 

Type the following on the Working Canvas below your initial equation for 
“s_recip”: 
 
# 
# Michaelis-Menten model with two terms: 
# 
Vmax1 = Vmax_CYP2C19 
Vmax2 = Vmax_CYP3A4 
# 
# Vmax1 and Vmax2 are respectively Vmax for the fast and slow acting  
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#    cytochrome P450 drug metabolizing enzymes. Vmax_CYP2C19 and  
#    Vmax_CYP3A4 will be two parameters to be estimated from the data. 
# 
v = (Vmax1*s)/(Km1 + s) + (Vmax2*s)/(Km2 + s) 
# 
 
Your Working Canvas will appear in part as follows: 
 

 
 

2. Associate the data and variable. 
 

a. In the Show menu, click Associations. The Associate Variables and Data 
dialog box will open as shown in the following: 

 

 
 

Note the entries in the Data Names box are the names of the columns in your 
data file. 

 
b. In the Variable Names (&Associated Data) box, click v. 
 
c. In the Data Names box, click sample1. 
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d. Click Associate. The Associate Variables and Data dialog box will appear 
as shown below: 

 

 
. 
e. Click Done. 

 
3. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively click the Parameter 

 tool on the SAAM II Toolbar.  The Parameters dialog box will open as 
shown below: 
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There are four parameters to be estimated from the data, Vmax_CYP2C19, 
Vmax_CYP3A4, Km1 and Km2. These are the four parameters describing the 
two Michaelis-Menten terms. 

 
b. Enter the parameters as shown in the following Parameters dialog box: 
 
 

 
 
c. Click Done. 

 
4. Solve the model, and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively click the Solve  tool on 
the SAAM II Toolbar. 

 
b. Plot the data. In the Show menu, click Plot, or alternatively click the Plot tool 

 on the SAAM II Toolbar.  The Plot and Table Variables dialog box 
will open. (Remember your last plot was the Eadie-Hofstee plot. However, 
you added the model equation after that plot. Thus when you plot after adding 
the equation, the previous plot will not open.) Be sure the List All Variables 
box is not checked. 

 
c. Click v:sample1 to move these to the Current Selection window. 
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d. Click Done.  The following plot will appear: 
 

 
 
 Notice the autoscale option is active for the plot scale; you can change it if 

you wish to better visualize the last few data. 
 
 Leave the Plot window open. 

 
5. Fit the model to the data, view the solution and statistics. 
 

a. In the Compute menu, click Fit, or alternatively click the Fit  tool on the 
SAAM II Toolbar.  Your plot will be updated as follows: 
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b. In the Show menu, click Statistics, or alternatively, click the Statistics  
tool on the SAAM II Toolbar.  With the plot open, the Working Canvas will 
appear (after moving the open windows) as follows: 
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You can see that the model provides a very good description of the data, and 
that the parameters are well estimated. 
 
Using antibodies against specific CYP enzymes, Kato and Yamazoe were able 
to identify the enzyme with the lower Km value as CYP 2C19, which 
demethylates diazepam, and the enzyme with the higher Km value as 
CYP 3A4, which forms the 3C-OH metabolite and also participates in 
demethylation.  These investigators also used their Km  and Vmax results to 
resolve a discrepancy between previous in vitro studies, in which 3-OH was 
reported to be the major metabolite of diazepam, and the in vivo observation 
that diazepam was primarily demethylated.  The following table which shows 
the relative contribution of the two CYP enzymes to diazepam metabolism 
indicated that this discrepancy resulted from the fact that much higher 
diazepam concentrations had been used for in vivo studies than are achieved in 
patients treated with this drug.  
 

 
[Diazepam] CYP 2C19 CYP 3A4 

In Vitro 100 μM 36% 64% 

In Vivo 2 μM* 70% 30% 

* usual concentration in patients: 1 – 2 μM. 
This demonstrates the utility of this type of detailed kinetic investigation and 
underscores the importance of conducting in vitro studies of drug metabolism 
at clinically relevant substrate concentrations.  A final point of 
pharmacogenetic importance is that phenotypic poor metabolizers of 
diazepam have defective CYP 2C19 activity and only one Michaelis-Menten 
term is needed to characterize diazepam metabolism by liver slices from these 
individuals. 

 
c. Close the Statistics window. Leave the Plot window open. 

 
Part 3. Create the Lineweaver-Burke, Hanes and Eadie-Hofstee plots. 
 
While you examined the Lineweaver-Burke and Eadie-Hofstee plots of the data, you will 
now create these with the model predicted values as well as the Hanes plot. 
 

1. Create the Lineweaver-Burke plot. 
 
To produce the Lineweaver-Burke plot, you need to add another equation to 
produce the model calculated “1/v”. 

 
a. Type the equation “v_recip = 1/v” under your equation for “s1_recip”; your 

Working Canvas will appear as follows: 
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Notice the plot will disappear. It has not been closed, and, as you will see, 
can be accessed from the Window menu. 

 
b. Re-Solve the model. (This is necessary to activate the equation for v_recip. 

Remember the parameter values have not changed from those which produced 
the best fit to the data.) 

 
c. In the Window menu, click Plot. Your plot will reappear on the Working 

Canvas, and be active. 
 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is selected. 
 
e. Type “s_recip” in the X-Axis box. 
 
f. Click v_recip, then press Ctrl and smp1recip. The Plot and Table Variables 

dialog box will appear as follows: 
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g. Click Done. Your plot will not be useful as, when you plotted the data, you 
need to change the scale. 

 
h. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
i. Set the X-Axis minimum and maximum values to 0.0 and 0.25 respectively. 

Set the Y-Axis minimum and maximum values to 0.0 and 16.0 respectively. 
The Plot and Table Scale dialog box will appear as follows: 
 

 
 

j. Click Done. Your Lineweaver-Burke plot will appear as follows: 
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2. Create the Hanes plot 

 
To create the Hanes plot, you need to add another equation for the model 
calculated value for “s/v”. 

 
a. Type the following on your Working Canvas: 

 
# 
# Setting up the Hanes plot 
# 
Hanes = s/v 
# 
 
Your Working Canvas will appear as follows: 

 

 
 
b. Re-Solve the model. 
 
c. In the Window menu, click Plot. Your plot will reappear on the Working 

Canvas, and be active. 
 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is selected. 
 
e. Type “s” in the X-Axis box. 
 
f. Click Hanes, and then press Ctrl and smp1sv. The Plot and Table Variables 

dialog box will appear as follows: 
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g. Click Done. Your plot will not be useful because the scale is set for the 
Lineweaver-Burke plot. 

 
h. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
i. Change the settings as follows: 

 

 
 

j. Click Done. Your Hanes plot will appear as follows: 
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3. Create the Eadie-Hofstee plot 

 
To create the Eadie-Hofstee plot, you need to add another equation for the model 
calculated value for “v/s”. 

 
a. Type the following on your Working Canvas: 

 
# 
# Setting up the Eadie-Hofstee plot 
# 
Eadie = v/s 
# 
 
Your Working Canvas will appear as follows: 
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b. Re-Solve the model. 
 
c. In the Window menu, click Plot. Your plot will reappear on the Working 

Canvas, and be active. 
 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is selected. 
Remember “s” is still the variable in the X-Axis box. 

 
e. Click Eadie, and then tress Ctrl and smp1vs. The Plot and Table Variables 

dialog box will appear as follows: 
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f. Click Done. Your plot will not be useful because the scale is set for the Hanes 
plot. 

 
g. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
h. Change the settings as follows: 

 

 
 

i. Click Done. Your Eadie-Hofstee plot will appear as follows: 
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j. Close all open windows. 
 
Quit the SAAM II Numerical application. You can save the numerical study file if you 
wish. 
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Essential Points to Remember 
 

 It is best to fit your “enzyme” kinetic data directly to a Michaelis-Menten model. 
That is, it is not necessary to transform you data to obtain the model parameter 
estimates (which is difficult if your model contains more than one Michaelis-
Menten term.) 

 You can easily plot your results in a transformed mode. This will require 
transforming your data, and writing the appropriate model equation. 
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